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1.1 Overview 
 
Dynamic Web Ranking is a powerful web analysis tool which will help you check your Web site 
position with ALL major search engines such as Google, AltaVista, Yahoo, Lycos, Excite. 
WebCrawler, MSN etc. Besides the free engines and pay-per-inclusion engines, we have also 
incorporated the major pay per click search engines into the application as well. This product 
works hand in hand with its companion product Dynamic Submission 2000 (Dynamic Submission: 
Submits your web site to hundreds of search engines). 
 
Web Ranking saves you untold hours of work a week by consistently and comprehensively 
monitoring your Web site's search engine positions while alerting you to problems.  With Web 
Ranking you'll have the reports you need to make improvements, correct problems, check your 
competitors web site and thereby increase your Web site's traffic without spending a penny in 
advertising!   
 
More importantly, Web Ranking provides you with practical guidance and tips to improve your 
pages so they'll rank better within the search engines!  Many people make the mistake of 
assuming that either there's no way to really improve their search positions or that improving 
them will not affect the bottom line in your business. It is a fact that major search engines such as 
Google, AltaVista, Yahoo, Lycos, Excite and WebCrawler account for over 85% of Internet traffic.  
If you achieve a good position for keywords that people are searching for, you will see a MAJOR 
increase of traffic to your web site. Since site visitors have specifically searched for your 
organization, product or service, they are highly qualified visitors and potential customers.  
 
Now with the release of Dynamic Web Ranking 4.0, the means of moving search rankings from 
an art to a science becomes possible.  Not every site will do well on the Internet. Only the ones 
who work smart by taking advantage of the right tools and strategies will be successful. 
 
Please note :  The trial version of Web Ranking is limited to the first three engines only. The trial 
version is just that and as such is designed to give you a feel as to how the application functions. 
To make good and practical use of this product you need to purchase a registration code within 
30 days to unlock the applications full potential. 
 
Once you order and receive your unlock code, you'll have access to all the engines. 
 
 
1.2 Features 
 
Here is a summary of the powerful features of Dynamic Web Ranking: 
 
1. Easy to use and user friendly interface  
 
2. Manage multiple projects for different set of keywords.  
 
3. Supports multiple Keywords for Multiple URLs 
 
4. Built-in keyword builder to help you to generate more relevant keywords  
 
5. Monitor your own URL or your competitors ranking 
 
6. Automatically send ranking reports by email when complete. (Pro version only) 
 
7. Flexible selection for checking any keywords or search engines and its combination  
 
8. Customizable keyword ranking reports  
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9. Export keywords and ranking results to Text or Excel database  
 
10. Auto Engine data file update to keep your engine data up to date 
 
11. Built in web site Optimizer to optimize your web site 
 
12. Automated ranking report in scheduler mode 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 

With Dynamic Web Ranking 4.0 you’re in charge! You create a project, associate websites with 
that project enter the keywords you are interested in and watch the application do all the work! 

 
Before you attempt to use this application please be sure to read the following section Getting 
Started . 
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1.3 Getting Started 
 
 
If this is your first time using Dynamic Web Ranking Version 4.0, please read this entire Section 
carefully before using the program. 
 
Follow the step-by-step instructions below to get started using your program: 
 
1. Establish your Internet connection  using Windows Dial-Up Networking or WinSock. 
 
2. Configuration:  You also need to configure your Internet connection. If you are connected to 
the Internet through a "Proxy Server", please enter your correct proxy server address and port 
number in the "File/Configuration" window. 
 

 
 
You find this window by selecting the File menu item and then clicking on configuration. 
 
The configuration box will appear. Be sure to configure all the settings by clicking the tab list 
across the top of the box to see all the parameters that may be configured.  

 

 
 
3. Download Engine Data File:  If you are running the program for the first time, the program will 
prompt you to download the Engine Data file to your PC from our web server when you open the 
program. You can also update the Engine Data file at any time by clicking the 'File/Update Engine 
Data' menu item. It will take less than 1 minute to download the new engine data from our Web 
site to your PC. 
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4. Create a Project:  You must create a project and place websites into the project. To do this 
click on the "Project" button from the toolbar, and specify your Project name, web site domains, 
select: search engines and click the OK button. You can use your company name or web site 
name for your Project. 
 
A Project contains all the information about your keywords, URLs and search engine details. It 
also contains the notification information and email address where the reports should be sent. 
 
5. Enter Keywords:  After you have created a Project, then click on the "Add Keyword" button 
from the Toolbar to add keywords to the Project.  An  "Add Keyword" window will popup, and you 
can enter your keywords or keyword phrase with one keyword per line then click the "OK" button. 
 
6. Ranking Look Up:  You can choose to do a single look up for selected keywords only or all 
keywords. Simply click the "Look Up" button from the Toolbar for selected keywords only, or click 
the "Look Up" drop down arrow button for look up ALL keywords. It may take several minutes to 
an hour to finish the look up depends on the number of your keywords. 
 
7. Generate Keyword Reports:  Once Look Up is completed; click the "Report" button from the 
Toolbar to create your Keyword Reports. You can create keyword reports in HTML, TEXT or 
Excel file format. 
 
 
1.4 Configuration 
 
You need to setup your Internet connection type, SMTP mail server and user profile before using 
the program. 
 
To start configuration, click the "File" menu item and choose "Configuration". 
 
Server 
 
HTTP server allows you to setup how do you connect to the Internet. If you are connected to the 
Internet through a "Proxy Server", please choose "Proxy Server" option and enter your correct 
"Proxy Server" and "Port" number. If you are not sure you are connected to the Internet through a 
"Proxy Server" or not, please contact your ISP or Network Administrator.  
 
By default, it is setup to "Direct Connection" 
 
SMTP mail server:  Please specify your SMTP mail server which will be used to send ranking 
reports. 
 
Connections 
 
Time Out: This allows you to specify how long the program should wait for a connection to the 
search engines before time out. By default is 30 seconds. 
 
Authentication:  If your server or proxy requires authentication before accessing to the Internet, 
please enter your authentication User Name and Password. You can obtain this information from 
your ISP or Network Administrator.  
 
Confirm connection before searching : This setting allows program to prompt you for the 
Internet connection before a search. You can uncheck this setting if you have a permanent 
connection. 
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Profile 
 
This information will be used to create your customized ranking reports. However, this feature is 
only available for the Professional Edition. The standard reports are available in all versions. 
 
 
1.5 Order Dynamic Web Ranking  
 
Please click on the "Help/Order" menu item from the menu bar of the program. You will be 
automatically connected to our on-line order page by clicking on the 'Order Now' button from the 
"Order Dynamic Software" screen. Once your payment is approved, n Order Confirmation with 
your registration code will be sent to you via email within 24 hours.  
 
We accept all major credit cards such as Visa, Master Card and American Express. You can also 
pay by International Money Order and Bank Cashier Check by printing out the order form and 
sending your payment to the address listed at the bottom of the order form page. 
 
Note:  The free trial demo version will be expired after 30 days. 
 
 
 
2.1 Create a ranking project 
 
A ranking Project contains all the information about your keywords, URLs and search engine 
details. You must create a ranking Project before entering any keywords or URLs. 
 
To create a new Project: 
1. Click the "Project" button from the toolbar, and "Project" window will popup. 
2. In the "Project" window, specify a Project name you want to create (You can use your company 
name or web site name for your Project name). 
3. Click the "Add URL" button to all URLs to your project. 
4. Click the "Engines" tab, and select the search engines you want to check your ranking for. 
(Note:  You can only select first 3 engines with free trial demo version) 
5. If you want to run the ranking automatically at a specified time, please click the "Scheduler" 
tab, and specify the time your want to run the ranking. 
6. If you want to send a ranking report to you or your client automatically when the ranking look 
up is completed, please click the "Report" tab, and specify the email address and the reports you 
want to send. 
7. Then click the OK button.  
 
Tips: 
1. You can also create a "Project" by click the "File" menu item from the menu bar and choose 
"Add Project" menu item. 
2. To open an existing "Project", click the "Project" button on the Toolbar and choose "Edit 
Project" button. 
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2.2 Add or Import keywords 
 
You can add your keywords in several different ways, you can enter your keywords manually, 
import keywords from a existing file, or copy and paste keywords from other search engines. 
 
Add keywords or Keyword Phrase Manually 
Click the "Add Keyword" button from the Toolbar to open the "Add keywords" window, then enter 
your keywords with one keyword per line, then click the "OK" button. You can enter multiple 
keywords at the same time. 
 
You can also click the "Keywords" menu item from the menu bar and choose "Add Keywords" 
menu item to open the "Add keywords" window. 
 
Import Keywords from a file 
If you already have a text file contains the keywords you want to look up, you can simply import 
the keywords to the program without enter manually. 
 
To import keywords from a file, please follow the steps below: 
 
1. Click the "Keywords" button from the Toolbar to open the "Add Keywords" window,  
2. In the "Add Keywords" window, click the "Import" tab and locate the keyword file you want to 
import. 
3. By default, the keyword file contains one keyword per line. If your keyword file is in another 
format, please select the delimited character from the list box, or simply enter any new delimited 
character you specified. 
4. Then click the OK button. 
 
You can also click the "Keywords" menu item from the menu bar and choose "Add Keywords" 
menu item to open the "Add keywords" window. 
 
 
2.3 Delete Keywords 
 
This will remove keywords from your keywords list.  
 
Simply select or highlight the keywords you want to remove, and press the "Delete" key or click 
the "Keywords" menu item from the menu bar and choose "Delete Keywords" menu item. 
 
To select multiple keywords, hold down the "Shift" or "Ctrl" key and select.  
 
2.4 Keyword Builder 
 
If you are not sure or don't know what keywords you should search for, the Keyword Builder is a 
powerful tool allows you to retrieve all relevant keywords for the keywords you chosen. It also 
shows you how many searches (or counts) each keywords have been searched, it is a very 
useful tool that tells you how important each keyword is. 
 
To start Keyword Builder, click the "Keywords" menu item and choose "Keyword Builder" to open 
the "Keyword Builder" window. Select a search engine from the drop down engine list box and 
enter a keyword in the "Keyword" box, then click the "Get" button. 
 
Once retrieving is completed, you can select the keywords you want to bid and click the "Add To 
List" button to add your selected keywords to the program. 
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You can also delete the keywords you don't want by clicking the "Delete" button. 
 
2.5 Export Keywords 
 
This allows you to export existing keywords to a text file.  
 
Simply select the keywords you want to export, and click the "Keywords" menu item from the 
menu bar, and choose "Export Keywords" menu item. Specify a file name you want to save as 
and click the OK button.  
 
The keyword will be save as one keyword per line. 
 
 
2.6 Add & Edit web site URL (or domains) 
 
This allows you to specify which web site that you want to monitor for the ranking position. 
Normally, you need to enter your web site domain name. However, you can also enter your 
competitor's web site URL so that you can track how well your competitor ranking is compared to 
yours.  
 
To Add or Edit web site URL: 
 
1. Open your Project profile window by clicking the "Project" dropdown arrow button from the 
toolbar, and choose "Edit Project" button. 
2. In the "Project" window, click the "Add URL" button.  
3. In the "Add URL" window, enter or select domains you want to use. 
(Note:  the free trial demo version supports 10 domains only. you cannot delete or change the 
domains once it has been added. So please check your domains carefully before add) 
 
4. Click the "OK" button 
 
Tips: 
1. You can also enter your competitor's domains to compare with yours. Simply select URLs you 
have entered, and click the "Set As Competitor" button. 
2. In the "Add URLs" window, select or un-select the domains you want to change from the list. 
3. Re-enter a new web site URL in the "Add URL" box at the bottom of the "Add URL" window, 
and click the "Add" button. 
 
 
2.7 Open URL in Browser 
 
It allows you to quickly open the selected URL in your default web browser.  
 
Simply Right mouse click on the URL and choose "Open URL in Browser" menu item. The default 
web browser will be launched and the web site will be loaded.  
 
You can also double click on the URL from the URL list box. 
3.1 About Ranking Look Up 
 
The ranking look up will perform keyword search on selected or all search engines and return the 
results of your position and matched URLs. It allows you to monitoring your ranking positions 
against your competitor, so that you will know what position you are in and how well your web 
sites are ranked in the search engines.  
 
You can perform multiple ranking look ups for multiple keywords for multiple domains on all 
search engines at the same time. 
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You can doing keyword look up in many different ways: 
 
 
3.2 Look Up Selected keywords 
 
This function allows you to perform ranking Look Up for selected keywords only.  
 
Please follow the steps below: 
 
1 Select the search engine from the engine list.  
2. Select (or Highlight) the keywords you want to look up from the keyword list box. (Please refer 
to the "Add or Import keywords" section for more information on how to Add or Import keywords) 
3. Click the "Look Up" button from the Toolbar or from the "Look Up" menu then choose "Selected 
Keywords". 
 
 
3.3 Look Up All Keywords 
 
This function allows you to perform ranking Look Up for ALL keywords for a select engine.  
 
Please follow the steps below: 
 
1. Select the search engine from the engine list.  
2. Click the "Look Up" dropdown arrow button from the Toolbar or from the "Look Up" menu then 
choose "Look Up All Keywords". 
 
 
3.4 Look up all keywords for all search Engines 
 
This allows you to perform a ranking look up for all keywords on all search engines.  
 
Please follow the steps below: 
 
1. Select a ranking project from the "Project" list box 
2. Click the "Look Up" drop down arrow button from the Toolbar or from the "Look Up" menu bar, 
then choose "All keywords for all engines" item. 
3. Once look up completed, you can generate a keyword report by clicking the "Report" button 
from the toolbar or menu bar. 
 
 
3.5 Automated schedule look up 
 
This allows you to perform ranking look up automatically at a regular time basis. You can specify 
the duration: weekly, monthly or quarterly, and the program will also send you a  ranking report 
via email automatically when the look up is completed. 
 
Please follow the steps below: 
 
1. Open the Project profile window by clicking the "Project" button on the toolbar. 
2. On the "Project" window, click the "Scheduler" tab . 
3. Choose the time period and specify the start time. 
 
4. If you want to send a ranking report to a specified email address, please click the 'Report" tab 
(Note: This feature is only available for the Professional Edition). 
5. Click the OK button. 
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3.6 Web Site Optimizer 
 
Web Site Optimizer is a powerful function that allows you to check and analyze your web site, 
and provides suggestions on how to improve your web ranking with an optimization report.  
 
It will check "keywords", "description", <title> meta tag, the first 200 characters of your web page 
contents, keyword density and provide you with the information on how to improve it. This will 
help you "optimize" your web page and get the best ranking on most major search engines. 
 
1. Click the "Report" drop down arrow button 
2. Choose "Web Site Optimizer" button. 
3. In the "Web Site Optimizer" window, enter your web site URL and click the "Optimize" button. 
4. Once complete, an optimization report will be displayed on your web browser. 
 
4.1 About Ranking Report 
 
After a Ranking, you may view the Results of the searches by pressing the Report button.  Your 
default Browser will then be launched in order to view your ranking reports. WebRanking will list 
the keywords/phrases you entered along with your ranking position. 
Report informs you of whether specific URL's or pages on your Web site have been listed near 
the top position.  Some search engines only index your home page.   
 
You'll also want to keep an eye on your competitors. You can then use this competitive 
intelligence as a tool to improve your own rankings.    
 
You can generate keyword reports in HTML, TEXT or EXCEL format.. By default, it is HTML 
format. The keyword report provides you following information about your web positions and 
changes: 
 
 
Project name 
Name of the Search Engine 
URLs: Web site URLs you are monitoring 
Keywords: The keywords you are bidding  
Position: Your current position 
Page: Page number of your position has been found 
Last Position: Your last position 
Change: position change since last look up 
URL: matched URL 
Status: The time the look up was perform 
 
 
4.2 Create ranking reports in HTML format 
 
To create ranking reports in HTML format, please follow the steps below: 
 
1. Select a Project from the project list 
2. Perform a ranking look up on all search engines 
3. Once look up completed, click the "Reports" menu item from the menu bar or Toolbar and 
choose "HTML Format" item. 
 
You can always generate a keyword report at any time by clicking the "Reports" menu item from 
the menu bar or Toolbar. 
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4.3 Create ranking reports in TEXT format 
 
To create keyword reports in TEXT format, please follow the steps below: 
 
1. Select a Project from the project list 
2. Perform a ranking look up on all search engines 
3. Once look up completed, click the "Reports" menu item from the menu bar or Toolbar and 
choose "TEXT Format" item. 
 
You can always generate a keyword report at any time by clicking the "Reports" menu item from 
the menu bar or Toolbar. 
 
 
4.4 Create ranking reports in Excel file Format 
 
To create keyword reports in Excel file format, please follow the steps below: 
 
1. Select a Project from the project list 
2. Perform a ranking look up on all search engines 
3. Once look up completed, click the "Reports" menu item from the menu bar or Toolbar and 
choose "Excel Format" item. 
 
You can always generate a keyword report at any time by clicking the "Reports" menu item from 
the menu bar or Toolbar. 
 
 
4.5 Customize keyword reports with my company details 
 
(Note:  This feature is only available for Professional Version) 
 
It allows you to customize your keyword reports with your company name, logo, web site URL 
embedded into the ranking reports. It is useful if you provide web ranking service for other people. 
 
To customize your keyword reports, simply enter your company details under the "Profile" section 
of the "Configuration" window.  
 
Please follow the steps below: 
1. Click the "File" menu item from the menu bar and choose "Configuration". 
 
2. In the "Configuration" window, click the "Profile" tab 
3. Enter all the details on the "Profile" tab and click OK. 
 
Note:  This feature is only available for the Professional Edition. 
 
 
4.6 Send Ranking Reports by email 
 
Note:  This feature is only available for Professional Edition. 
 
This function allows to send ranking reports automatically to your email address. This feature is 
useful if you provide ranking service for other people.  
 
You can send ranking reports in two ways: 
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1. Send ranking report automatically when complete:  
 
 
1). Open your Project profile window,   
2). Click the "Report" tab. 
3). Specify the email address, subject line and report type,  
4). Then click the OK button 
 
or 
 
2). Send ranking report manually at any time: 
     1). Click the "Report" button from the toolbar. 
     2). Choose "Send Report" button. 
     3). In the "Send Report" window, enter the email address, subject line and the report type. 
     4). Click the "Send" button. 
 
 
5.1 Update Engine Data file  
 
It allows you to download the latest set of engine data files from our web server to your PC. The 
process normally takes under one minute. 
 
To make sure your look up results are accurate, please update the Engine Data file frequently 
about once per month to keep your engine data files up to date. 
 
If you have problems to update engine data file, or having problems connecting to our web 
server, please check your "Connections" setting in the "Configuration" window and make sure you 
have enter the correct "Proxy Server" address if you are connected to the internet through a 
proxy server, then try again. 
 
 
5.2 Create a ranking project 
 
A ranking Project contains all the information about your keywords, URLs and search engine 
details. You must create a ranking Project before entering any keywords or URLs. 
 
To create a new Project: 
1. Click the "Project" button from the toolbar, and "Project" window will popup. 
2. In the "Project" window, specify a Project name you want to create(You can use your company 
name or web site name for your Project. name). 
3. Click the "Add URL" button to all URLs to your project. 
 
4. Click the "Engines" tab, and select the search engines you want to check your ranking. (Note: 
You can only select first 3 engines with free trial demo version.) 
5. If  you want to run the ranking automatically at a specified time, please click the "Scheduler" 
tab, and specify the time your want to run the ranking. 
6. If you want to send a ranking report to you or your client automatically when the ranking look 
up is completed, please click the "Report" tab, and specify the email address and the reports you 
want to send. 
 
7. Then click the OK button.  
 
Tips: 
1. You can also create a "Project" by click the "File" menu item from the menu bar and choose 
"Add Project" menu item. 



'\QDPLF�:HE�5DQNLQJ�YHUVLRQ�����

 

�

14 

2. To open an existing "Project", click the "Project" button on the Toolbar and choose "Edit 
Project" button. 
 
 
5.3 Delete Project 
 
It allows you to delete a keyword Project from the project list. 
 
To delete a project, simply select the project you want to delete from the list, and the "Project" 
menu item from the menu bar and choose "Delete Project" item. 
 
You can also delete a Project by click the Delete key. 
 
 
5.4 Add or Import keywords 
 
You can add your keywords in several different ways, you can enter your keywords manually, 
import keywords from a existing file, or copy and paste keywords from other search engines. 
 
Add keywords or Keyword Phrase Manually 
Click the "Add Keyword" button from the Toolbar to open the "Add keywords" window, then enter 
your keywords with one keyword per line, then click the "OK" button. You can enter multiple 
keywords at the same time. 
 
You can also click the "Keywords" menu item from the menu bar and choose "Add Keywords" 
menu item to open the "Add keywords" window. 
 
Import Keywords from a file 
If you already have a text file contains the keywords you want to look up, you can simply import 
the keywords to the program without enter manually. 
 
To import keywords from a file, please follow the steps below: 
 
1. Click the "Keywords" button from the Toolbar to open the "Add Keywords" window,  
2. In the "Add Keywords" window, click the "Import" tab and locate the keyword file you want to 
import. 
3. By default, the keyword file contains one keyword per line. If your keyword file is in another 
format, please select the delimited character from the list box, or simply enter any new delimited 
character you specified. 
4. Then click the OK button. 
 
You can also click the "Keywords" menu item from the menu bar and choose "Add Keywords" 
menu item to open the "Add keywords" window. 
 
 
 
5.5 Import keywords from a file 
 
If you already have a text file contains the keywords you want to look up, you can simply import 
the keywords to the program without enter manually. 
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To import keywords from a file, please follow the steps below: 
 
·  Click the "Keywords" button from the Toolbar to open the "Add Keywords" window,  
 
· In the "Add Keywords" window, click the "Import" button and locate the keyword file you want to    
import. 
 
·  By default, the keyword file contains one keyword per line. If your keyword file is in another 
format, please select the delimited character from the list box, or simply enter any new delimited 
character you specified. 
 
·  Then click the OK button. 
 
You can also click the "Keywords" menu item from the menu bar and choose "Add Keywords" 
menu item to open the "Add keywords" window. 
 
 
5.6 Export keywords to a file 
 
This allows you to export existing keywords to a text file.  
 
Simply select the keywords you want to export, and click the "Keywords" menu item from the 
menu bar, and choose "Export Keywords" menu item. Specify a file name you want to save as 
and click the OK button.  
 
The keyword will be saved as one keyword per line. 
 
 
5.7 Add & Edit web site URL (or domains)  
 
This allows you to specify which web site do you want to monitor for the ranking position. 
Normally, you need to enter your web site domain name. However, you can also enter your 
competitor's web site URL so that you can track how well is your competitor ranking compare to 
yours.  
 
To Add or Edit web site URL: 
 
1. Open your Project profile window by clicking the "Project" dropdown arrow button from the 
toolbar, and choose "Edit Project" button. 
2. In the "Project" window, click the "Add URL" button.  
3. In the "Add URL" window, enter or select domains you want to use. 
(Note: the free trial demo version supports 10 domains only. you can not delete or change the 
domains once it has been added. So please check your domains carefully before add) 
 
4. Click the "OK" button 
 
Tips: 
1. You can also enter your competitor's domains to compare with yours. Simply select URLs you 
have entered, and click the "Set As Competitor" button. 
2. In the "Add URLs" window, select or un-select the domains you want to change from the list. 
3. Re-enter a new web site URL in the "Add URL" box at the bottom of the "Add URL" window, 
and click the "Add" button. 
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5.8 Automated schedule look up  
 
This allows you to perform ranking look up automatically at a regular time basis. You can specify 
the duration by weekly, monthly or quarterly, and the program will also send you a ranking report 
via email automatically when the look up is completed. 
 
Please follow the steps below: 
 
1. Open the Project profile window by clicking the "Project" button on the toolbar. 
2. On the "Project" window, click the "Scheduler" tab . 
3. Choose the time period and then specify the start time. 
 
4. If you want to send a ranking report to a specific email address, please click the 'Report" tab 
(Note: This feature is only available for the Professional Edition). 
5. Click the OK button. 
 
 
5.9 About Ranking Report  
 
After a Ranking, you may view the Results of the searches by pressing the Report button.  Your 
default Browser will then be launched in order to view your ranking reports. Web Ranking will list 
the keywords/phrases you entered along with your ranking position. 
Report informs you of whether specific URL's or pages on your Web site have been listed near 
the top position.  Some search engines only index your home page.   
 
You'll also want to keep an eye on your competitors. You can then use this competitive 
intelligence as a tool to improve your own rankings.    
 
You can generate keyword reports in HTML, TEXT or EXCEL format.. By default, it is HTML 
format. The keyword report provides you following information about your web positions and 
changes: 
 
 
Project name 
Name of the Search Engine 
URLs: Web site URLs you are monitoring 
Keywords: The keywords you are bidding  
Position: Your current position 
Page: Page number of your position has been found 
Last Position: Your last position 
Change: position change since last look up 
URL: matched URL 
Status: The time the look up was perform 
 
 
5.10 Customize keyword reports with my company details 
 
(Note: This feature is only available for Professional Edition) 
 
This feature allows you to customize your keyword reports with your company name, logo and 
web site URL embedded into the ranking reports. It is useful if you provide web ranking services 
for other people or companies. 
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To customize your keyword reports, simply enter your company details under the "Profile" section 
of the "Configuration" window.  
 
 
Please follow the steps below: 
1. Click the "File" menu item from the menu bar and choose "Configuration". 
2. In the "Configuration" window, click the "Profile" tab 
3. Enter all the details on the "Profile" tab and click OK. 
 
Note: This feature is only available for the Enterprise Edition. 
 
 
 
5.11 Send Ranking Reports by email 
 
Note: This feature is only available for Professional Version. 
 
This function allows to send ranking reports automatically to your email address. This feature is 
useful if you provide ranking service for other people.  
 
You can send ranking reports in two ways: 
1. Send ranking report automatically when complete:  
 
1). Open your Project profile window,  
2). Click the "Report" tab. 
3). Specify the email address, subject line and report type,  
4). Then click the OK button 
 
or 
 
2. Send ranking report manually at any time: 
1). Click the "Report" button from the toolbar. 
2). Choose "Send Report" button. 
3). In the "Send Report" window, enter the email address, subject line and the report type. 
4). Click the "Send" button. 
 
 
6.1 About Keywords 
 
The keywords you used for ranking will affect the results of your positions.  
 
For example, if you don't achieve a good ranking on "cheap holidays," keep trying, but also be 
creative and target "inexpensive holidays" as well.  It's all about thinking like your customer or 
clientele - and it's really pretty easy to find a keyword combination that you can dominate in the 
search engines.  You'll often find that there are more people searching for these other phrases 
than were searching for the original phrase you thought of.  In marketing, this is called carving out 
your niche.   
 
In the WebRanking keyword box, type in the keywords or phrases EXACTLY like you think a user 
would enter it in one of the search engines to find a site like yours.  If you wish to simulate the 
user doing an exact phrase search, surround the phrase with a double quote (") character.  Doing 
this by hand would be next to impossible, but WebRanking makes it very easy. 
 
For example, you could tell WebRanking to search on both: Computer Books and also "Computer 
Books". You'll find that you will likely rank differently on each depending on the design of your 
page and the engine.  Most search engines will find the exact phrase search on your page ONLY 
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if the words "Computer Books" appear on your page with those two words all together and the 
case of the words are the same.  Therefore when designing pages, its important to integrate the 
most likely phrases people would use to find a site like yours into your page's text.  Without the 
quotes, most engines will simply look for a page that happens to contain all of the above words 
and put the so-called best matching or most "relevant" pages at the top of the list.   Which will the 
user type?  The more experienced Web users will try to do an exact phrase search first, and then 
they will try an inexact search if that doesn't yield any good results.  Novice users may not know 
to use the exact phrase option unless the search engine defaults to that.   Advice: Monitor your 
positions for both. 
 
 
6.2 Selecting the BEST keywords/phrases 
 
There are several things to consider when choosing keywords and phrases.  The most important 
is to put yourself in the shoes of the type of visitor you want to attract.  Make a list of what kind of 
keywords or phrases they are likely to search on.  This requires you to separate yourself from 
your product, service or web site and think like the average Joe who might want to find you, but 
knows nothing about your site.   
 
It's a good idea to ask friends or co-workers what they might type in to find your site, or even have 
them go to a search engine and tell them to try and find information on the topic your site 
happens to cover.  Watch what words and phrases they use. 
 
Important things you want to remember when picking keywords to target: 
CONCEPTS:  Include concept keywords such as "web promotion software" if that's what you sell, 
but also try and be specific enough so that it’s not too broad. 
BRANDS:  Include more specific brand names such as Microsoft.  If you offer services, then try to 
use service brand names when possible.  Legally, you should put the ® reserved symbol or ™ 
trademark symbol after the names when mentioning them on the page.   
 
COMPANY NAMES:  If you offer products from a well known company, include that company's 
name in your keywords. Unless you are a well known company/organization such as Microsoft or 
Apple, it’s generally less important to emphasize your name as a keyword.   
 
COMMON WORDS: There are now so many pages and words indexed on the Web, that a 
search on many common words such as "software" or "Internet" are going to be completely 
ignored for that search by the engine!  Therefore, most people have to search on two or three 
word phrases to find what they're looking for.  Trying to be listed well on every phrase/keyword 
combination they might search for next to impossible.   
 
TEST KEYWORDS:  Ideally, before you even start a new Internet Web site (or even after), you 
should see how many other pages match the keywords people would likely search on to find you.  
The fewer matches found for your search, the easier it will be to get your name up near the top.  
Also important are the quality of the matches that appear.  Your keywords may only bring up a lot 
of garbage that your potential audience would have no interest in anyway.  Therefore, with the 
proper strategy, you could be the only site of your type that appears near the top of that search.  
WebRanking's ranking report will let you see what competing pages/sites you are up against.  
There may be phrases that people are likely to search for which are much easier to achieve good 
rankings on than more common words and phrases.  This strategy can gain you unexpected new 
traffic. 
 
PHRASES:  As mentioned, many people will likely use multiple word phrases to find you 
particularly when single words do not provide adequate scope for the search.  The syntax for this 
varies by engine but generally phrases are searched for by surrounding them with quotes.  
Therefore, make a list of 2-3 word phrases people are likely to search for.  When placing 
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keywords on your page, make sure you always include them in a phrase that the visitor might 
use.   
 
Keep the important words chained together in sentences on the page.  If the user searches on 
"KEYWORD1" AND "KEYWORD2" then you only have to have the words in the same proximity 
on the page.  If, however, they search on "KEYWORD1 KEYWORD2" along with the surrounding 
quotes, then the words MUST be together on your page, preferably multiple times to find a match.  
Therefore, it’s a good idea to monitor your position for both "web site promotion" and just web site 
promotion as an example.   
 
Optimizing your page for phrase searches can do wonders in helping people find you.  However, 
because of the many combinations it’s traditionally been an impossible task without a tool like 
WebRanking to help you monitor your results.  It’s often difficult to rank well for popular keywords.  
However, few sites make serious efforts to optimize for common phrases leaving you with great 
opportunities to increase your traffic! 
 
CASE-SENSITIVITY:  If the user types the word Aircraft then most engines will search for 
"Books" with an uppercase "B" ONLY.  If your page has only "books" in it, you will not be found!  
On the other hand, if they search for "books" and your page has "Books" on it, most engines 
default to finding words of any case when the keyword used was in all lower case.  Therefore, it 
pays to make sure you have at least some of the keywords in uppercase or starting with an 
uppercase letter if the user might search that way.  The easiest place to do this is in the title of the 
page, in meta tags, and at the beginning of sentences. 
 
After you've entered your keywords, ran  the WebRanking, and viewed the results, the next step 
will be to improve your rankings by studying our tips section. 
 
 
 
6.3 Why your rankings can and will change ? 
 
Search engine databases are very dynamic with thousands of new pages being added to their 
indexes daily.  These new and updated pages can easily affect your search positions and push 
you down the list. 
 
Search engines often change the algorithm they use to rank pages.  Therefore, your page may 
rank well today but rank poorly under the new algorithm tomorrow.  The engines of course will 
almost never inform you of these kinds of changes. 
 
Errors often occur with search engines causing them to lose pages at random.  Therefore, it’s 
important to know you're still in their database and whether you need to resubmit. WebRanking 
solves these problems by performing and organizing the searches for you. 
 
 
6.4 Why you need to use Dynamic Web Ranking ?  
 
There are at least a dozen major search engines that you must submit your pages to and monitor. 
If you offer more than one product or service, you must monitor MORE than just one page. You 
must also monitor and improve all of your product or service pages as well to stay competitive !  
Many people overlook this important concept and lose valuable traffic to their competition. 
 
For each product or service you offer, there could be a dozen or more keywords or combination 
of keywords that the user might search on to find you.  A good ranking with each word/phrase can 
significantly improve your site's traffic. However, it is difficult to tracking your position by going to 
each search engines individually and searching by hand. For an example, if you have one 
product or service to promote, that will be 8 major engines * 1 products/services * 12 
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keywords/phrases = 96 positions to monitor. If you have 6 products/services then there are 480 
positions to monitor ! Obviously, nobody has time to do 480 searches a week AND  record all the 
results of every search AND have time to take corrective action.   
 
If your Web site happens to offer dozens of products or services, you already know tracking your 
search positions is an impossible task, unless of course you employ WebRanking to do that work 
for you! 
 
 
6.5 How can Dynamic Web Ranking improve your search position?  
 
By running WebRanking and viewing the analysis reports of your web search positions, you can 
easily INCREASE your site traffic several hundred percent or more!  Many sites can bring in 
thousands of qualified visitors per month simply by being properly indexed with major search 
engines. This is the most inexpensive and most effective means of advertising you can utilise for 
your Web site. It's really quite simple. By having a tool that makes it practical to continually 
improve your search rankings, you can maximize the visibility of your Web site.   
 
Let's say you sell 'Music CDs'.  You can make sure at least one of your pages appears in at least 
the top 50 positions when someone does a search on "Music", "CD", "Music CD", "Entertainment" 
and so forth.  If one of your pages ranks well on one keyword but poorly on the others, by using 
WebRanking,  you can easily identify problems and work to improve your  ranking for many of 
those "other" keywords people might search on.  It doesn't take many improvements to 
significantly increase your visibility.  This can add up to what amounts to thousands of dollars 
worth of FREE advertising!  Your customers will even thank you for making yourself easy to find. 
 
Further, Web Ranking also provide a "Web Site Optimizer" function to analyse your web and 
provide suggestions on how to improve your web tanking. For more details, please check "Web 
Site Optimizer". 
 
 
6.6 Stay on TOP of your competitors 
 
WebRanking lets you keep tabs on your competition and how their Web site ranks in relation to 
yours.  With your Web Ranking reports, you can easily find your competition's page and use this 
competitive intelligence as a tool to improve your own rankings.    
 
If you run or work in a business, you know the importance of good management.  WebRanking 
gives you the reports you need to monitor trends and manage your Web Site's visibility.  If one of 
your pages has been gradually moving down in ranking, you can quickly identify the problem and 
develop a strategy to correct it.  Without this report, you often have no way to even know the 
problem exists except by seeing a decrease in site traffic.  However, by that point, you've already 
lost out on valuable sales of your product/service but you wouldn't know why!   
 
 
6.7 Your submission strategy 
 
If you're serious about improving your Web site's visibility and thereby increasing your site traffic, 
you must have a plan of action.  Improving your Search Engine positioning is not an 
instantaneous thing, but instead, it's a PROCESS.  WebRanking together with Submission 2000 
makes this process much easier and therefore becomes invaluable in improving your site's 
positions and ultimately increasing your traffic.  
 
There's no way to make every page rank well with every search engine for every keyword or 
phrase someone might use.  However, you can work to make at least one page in your Web site 
rank near the top for each engine.  Ideally, you'll want one of your pages to be positioned well for 
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each of your  primary keywords.  This may take some thought on how to setup your pages to 
achieve the desired results.  Study the section on "Tips to Improve your Search Rankings" for 
ways to do this. 
 
Here's an outline of the general strategy we recommend: 
 
(1). Check your site's visibility as it stands today.  If your Web site has already been submitted to 
one or more of the search engines, you'll want to find out how well you rank right now for 
keywords and phrases people might use to find you.   
 
(2). Is your page listed in the top 30 to 50 positions for your primary keywords?  If not then please 
visit and study your competitor's Web site. Use this competitive intelligence as a tool to improve 
your own rankings, redesigning some of your pages (or creating new ones) and then 
resubmitting. 
 
(3). If you're not in the top 50 now, you'll probably want to change the pages or links of 
WebRanking's default Matches to Search.  If you scan a couple hundred matches and find your 
listing, you'll be able to track your progress better, and see whether your changes and re-
submissions are moving you up or down the list.  Beware that your searches will take longer the 
more records you search.  
 
(4). If at least one of your pages is already in a top 30 position with some engines but not others, 
study and understand why your pages are not ranking as well as they could. Even minor changes 
in page design combined with re-submission can have significant effects on your traffic.  There's 
also no other more cost-effective way to increase traffic to your site.   
 
(5). Re-submit your pages again on a regular basis. Make sure your page design has been 
optimized for keyword searches, and then resubmit.  If you just submitted recently, make sure 
you've allowed enough time for the engine to add your page to their database.  You can find out 
their current lag time for indexing new sites by going to the engine's submit area. 
 
(6). Study the section on 'Tips to Improve your Search Rankings' as well as other tips and 
resources found on the Web.  
 
(7). Your rankings may move up or down dramatically from day to day.  When this happens, you'll 
need to understand WHY.  Each search engine is different and continually changes and adds 
new pages to its index every day.  These things will effect your positions over time and 
sometimes very quickly.  We recommend you keep careful notes on when you submitted or 
resubmitted to each engine and what pages you submitted.  You may even wish to create sub-
directories with different copies of your Web site at various stages.   
 
 
6.8 Tips on how to improve your web ranking  
 
Choose a right Title 
 
Firstly, make sure each page of your site has a descriptive title. Because search engines usually 
give the most weight to the page's title, you should place a descriptive phrase between the 
<TITLE> tags. For best results, it is advised that you keep it within 200 characters and to-the-
point. Also, since search engines return the title as the search results, your HTML title should be 
both descriptive and attractive. 
 
For example, the following title describes well the site, and therefore is a good choice: 
 
<TITLE>Dynamic Web promotion software - submit your web sites to 1000+ major search 
engines.</TITLE> 
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<META> tags  
You can control how search engines catalog your site with <META> tags. Not all search engines 
make use of these tags, but using them will definitely improve your position in those that do. All 
<META> tags should be placed within the <HEAD>...</HEAD> portion of the document. 
 
The <META> description tag lets you specify a short summary about your web site. This tag 
should clearly describe what one can find at your Web site. Here's an example: 
 
<META NAME="description" CONTENT="#1 best selling 5 star award winning web promotion 
and site submission software. Increase your web site traffic by submitting your sites to 1000+ 
search engines."> 
 
Some search engines limit the description to 200 characters. To be on the safe side, make sure 
your description does not exceed 200 bytes (characters). If you do not use <META> tags to 
describe your site, the Web page description will be derived from the first 200 characters in the 
HTML <BODY>...</BODY> portion. Also note that there should be only one <META> description 
tag per page. 
 
The <META> keywords tag lets you specify a set of keywords that a search robot should give 
precedence to when cataloging the page or how people can find your web site. Here's an 
example: 
 
<META NAME="keywords" CONTENT="web promotion, site submission, 
web advertising, increase traffic, promotion software, web site promotion"> 
 
The keywords can include up to 1000 characters of text. Be sure that the 
keywords you choose are relevant to the contents of your page. Note that the keywords are used 
in the indexing process but will not display on your Web page or on a search response page. Try 
to incorporate singular and plural cases of words, as well as active and passive verbs. Also make 
sure your keyword list includes both general and specific words related to your site. You rarely 
want to target a single keyword, because, with the billions of words indexed on the Web now, one 
word simply won't cut it. Always use phrases, not plain words, in your list. 
 
Frame 
Sites using frames should definitely make use of <META> tags. The main HTML file contains the 
<FRAMESET> tags, but fails to provide robots with any real useful information about the Web 
site. Therefore, you should utilize the <META> description tag to provide a description, 
summarizing the site's contents. If JavaScript (or any other scripting language) makes up the first 
several hundred characters on your page, you should use the <META> description tag so your 
site comes up with a meaningful description in search results. 
 
Web Site Contents 
Search engines rely mostly on word density (frequency relative to the total size of the page) or 
distribution (how well the word is spread throughout the page). Some search engines even give 
precedence to text near the top of a Web page, so make sure you place the most important stuff 
at the top. Furthermore, search engines that do not support <META> tags use the first 200 (or 
250) characters for the site's description, so the first paragraph should describe/sell your service. 
 
Use <Hn>...</Hn> for headers, rather than the <FONT>...</FONT> tag definition. Some search 
engines consider header text particularly important. 
 
Image Description 
If your site mainly consists of images, you should use the ALT attribute to 
describe each image. Most search engines index the ALT attribute in the <IMG> tag. The 
following HTML definition shows how to use this attribute: 
 



'\QDPLF�:HE�5DQNLQJ�YHUVLRQ�����

 

�

23 

<IMG SRC="image.gif" HEIGHT="486" WIDTH="60" ALT="Web 
Site Promotion"> 
SPAM 
The overuse and repetition of keywords may result in a lower relevancy score and possible 
omission from some search engines. Most search engines count only the first few occurrences of 
a keyword or phrase, and some even penalize you for repeating words to improve your site's 
ranking. Infoseek and Lycos are two search engines that penalize sites that are suspected of 
repeating keywords, and AltaVista will disallow URL submissions from those who spam the index. 
Some search engines penalize your site if a keyword is repeated more than three times. 
Don't try to fool a search engine by using the phrase "web promote" three times, and the phrase 
"web promotion" another three times. Search engines are smarter than that, but they still aren't 
smart enough to associate "promote" with "promotion." 
 
 
7.1 Configuration 
 
You need to setup your Internet connection type, SMTP mail server and user profile before using 
the program. 
 
To start configuration, click the "File" menu item and choose "Configuration". 
 
Server 
 
HTTP server allows you to setup how do you connect to the Internet. If you are connected to the 
internet through a "Proxy Server", please choose "Proxy Server" option and enter your correct 
"Proxy Server" and "Port" number. If you are not sure you are connected to the Internet through a 
"Proxy Server" or not, please contact your ISP or Network Administrator.  
 
By default, it is setup to "Direct Connection" 
 
SMTP mail server:  Please specify your SMTP mail server which will be used to send ranking 
reports. 
 
Connections 
 
Time Out:  This allows you to specify how long the program should wait for a connection to the 
search engines before time out. By default is 30 seconds. 
 
Authentication:  If your server or proxy requires authentication before accessing to the internet,  
please enter your authentication User Name and Password. You can obtain this information from 
your ISP or Network Administrator.  
 
Confirm connection before searching:  This setting allows program to prompt you for the 
Internet connection before a search. You can uncheck this setting if you have a permanent 
connection. 
 
Profile 
 
This information will be used to create your customized ranking reports. However, this feature is 
only available for the Professional Edition. 
 
 
7.2 Update Engine Data file 
 
It allows you to download the latest set of engine data files from our web server to your PC. The 
process normally takes under one minute. 



'\QDPLF�:HE�5DQNLQJ�YHUVLRQ�����

 

�

24 

 
To make sure your look up results are accurate, please update the Engine Data file frequently 
about once per month to keep your engine data files up to date. 
 
If you have problems to update engine data file, or having problems connecting to our web 
server, please check your "Connections" setting in the "Configuration" window and make sure you 
have enter the correct "Proxy Server" address if you are connected to the internet through a 
proxy server, then try again. 
 
 
7.3 Troubleshooting and Frequently Asked Questions 
 
7.3.1 I am getting a "connection" error when doing look up, why?  
 
In most case, this is because you did not setup your Internet connection properly. If you are 
connected to the Internet through a "Proxy Server", please make sure to enter your correct "Proxy 
Server" address in the "Configuration" setup window and try again. If you are not sure whether 
you are connected to the Internet through a "Proxy" or not, please contact your ISP or Network 
Administrator for help. 
 
7.3.2 How many URLs I can monitor? 
 
7.3.3 Can I customize the keyword report with my company details? 
 
This feature is only available for the Professional Edition. Please refer to the  
"Customize Keyword Reports with my company details" section for more information. 
 
7.3.4 What is the limitation for the evaluation version? 
 
You can only rank for 3 engines and 10 domains with the demo version and the program will be 
expired after 30 days. After 30 days free trial period is over, the program will be disable and you 
must purchase a registration code to unlock the program if you want to continue use. 
 
7.3.5 What is the different between Standard and Professional Edition? 
 
The Standard Edition only allows you to rank up to 10 domains and you cannot customize the 
Keyword Reports with your company details.  
 
Normally, the Standard Edition is suitable for individual users, and Professional Edition is suitable 
for people who provide web ranking service for other people. 
 
There is no limitation for the Professional Edition and you can also customize the Keyword 
Reports with your company details. 
 
7.3.6 How often should I update the Engine Data File? 
 
If you cannot receive the correct search results from the search engines, then it is the time to 
update your engine data file. We will keep monitoring and update the Engine Data File frequently 
and add some more "Pay-Per-Click" search engines from time to time. As a general rule, you can 
update your engine data file once per month. 
 
7.3.7 I receive a "Registration Canceled" error when register the program, why? 
 
If you are receiving an error message display that "Your registration code has been canceled", 
this is because we are using a online authentication system to track each registration code when 
you use your software each time. Although our server is active over 99% of the time, occasionally 
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it does go down. If you receive a message informing you that your registration code has been 
canceled, please follow the instruction below to re-activate your registration code: 
 
1. Connect to the Internet and Open the "Register" window. 
2. If you are connected to the Internet through a "Proxy Server", please make sure to enter your 
correct "Proxy Server" address in the "Configuration" setup window. 
3. Check your "Register Name" carefully and make sure it is entered correctly as we provided. 
4. Click on the "Active" button and follow the instruction on the screen. 
5. Close the program and re-start. 
 
7.4 Technical Support  
 
Please check the "Troubleshooting and FAQ" section before contacting our support.  
 
We continually provide free technical support for all registered clients. You can receive additional 
information and technical support in the following ways: 
 
WWW 
Look for updated information and easy solutions to common problems on our WWW site, at 
http://www.apexpacific.com/faq.html  
 
Email 
Send us an e-mail message with full details of your problem to:  support@apexpacific.com 
 
With this method, your problem can be better described and it also alleviates time zone problems. 
 
Phone 
 
Phone our support Helpline at (AU) +612 9662 3433. Fax: (AU)+612 9662 3422. 
 
 
8.1 Order Dynamic Web Ranking  
 
Click on the "Help/Order" menu item from the menu bar and follow the instructions on the "Order" 
window. 
 
Please click on the "Help/Order" menu item from the menu bar of the program. You will be 
automatically connected to our on-line order page by clicking on the 'Order Now' button from the 
"Order Dynamic Software" screen. Once your payment is approved, n Order Confirmation with 
your registration code will be sent to you via email within 24 hours.  
 
We accept all major credit cards such as Visa, Master Card and American Express. You can also 
pay by International Money Order and Bank Cashier Check by printing out the order form and 
sending your payment to the address listed at the bottom of the order form page. 
 
Note: The free trial demo version will be expired after 30 days. 
 
 
8.2 What is Registration? 
 
This software has a trial version.  This means that we have made the software available to you for 
free evaluation.  You are entitled to evaluate the software for up to 30 days without obligation to 
pay.  After 30 days, if you decide to keep the software, you must register your copy with our 
authorized reseller or us. 
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The trial version has some limitations:  
 
  1. You can only check up to 10 domains (includes competitors domains) 
  2. Nag-screen. 
 
  3. You can't use the software after 30 days trial period. 
 
 
 
8.3 Why should I Register?  
 
For many people, the most pressing reason to register is to get rid of the annoying nag box which 
pops up at the most inconvenient times. 
 
But besides this, Registration entitles you free technical support and minor upgrades to the 
software.  Registration may also entitle you to discounts on other software releases from our 
company. We will also send you information bulletins by email to let you know about what's 
happening with our products. 
 
Further more, by registering the software, you provide us with the resources and incentive to 
support the software with updates and to develop additional quality products in the future. 
 
 
8.4 About Registration Key  
 
Entering your Registration Key 
 
After purchasing a key you will be sent an email containing your key and detailed instructions on 
how to enter it into Dynamic Web Ranking. 
 
Simply click the "Help" menu item from the menu bar and choose "Register", and enter your 
registration details then click the "Register" button. You will be connected to our online 
authentication database to verify your registration code. 
 
Invalid Registration Key 
 
If you receive a message informing you that your key is invalid, please take the following steps 
before contacting Technical Support: 
 
1. Check your Register Name careful and make you have enter the correct Register Name 
exactly as we provide in the "Order Confirmation" email. 
2. Check your registration code is entered correctly. The key is case specific and contains no 
spaces. Please use "Copy" and "Paste" function to enter your registration key. 
 
 
Your registration code has been cancelled 
 
If you are receiving an error message display that "Your registration code has been canceled", 
this is because we are using a online authentication system to track each registration code when 
you use your software each time. Although our server is active over 99% of the time, occasionally 
it does go down. If you receive a message informing you that your registration code has been 
canceled, please follow the instruction below to re-activate your registration code: 
 
 
 
1. Connect to the Internet and Open the "Register" window. 
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2. If you are connected to the Internet through a "Proxy Server", please make sure to enter your 
correct "Proxy Server" address in the "Configuration" setup window. 
3. Check your "Register Name" carefully and make sure it is entered correctly as we provided. 
4. Click on the "Active" button and follow the instruction on the screen. 
5. Close the program and re-start. 
 
If this does not work, please contact Apex Pacific or authorized dealer with your Client ID# for 
help.  
 
 
 
 
9.1 About Apex Pacific 
 
Apex Pacific Pty Ltd is a leading Internet Marketing software company that specializes in 
developing advanced Internet Web Promotion application solutions. Our company conducts 
intensive and extensive research and development in the fields of Web promotion mechanisms 
and advanced intuitive user interfaces for implementation on the Internet.  
 
The Dynamic Web Promotion Software range contains all of the most powerful #1 "ALL-IN-ONE" 
Internet marketing and web promotion tools that you need to explode your business on the 
Internet. We are widely recognized as the world leader in quality  
 
Apex Pacific's groundbreaking Dynamic Submission 2000, is an a multi-award winning "ALL-IN-
ONE" professional web promotion tool that automatically submit your web site to 1000+ major 
search engines with just a few button clicks and provides you the tools to get your web site to be 
listed at the TOP position of all major search engines.  
 
We at Apex Pacific are especially dedicated to providing smart solutions and applications for the 
Internet marketer. We have extensive experience in building high quality and professional Internet 
marketing tools and applications. With Apex Pacific's guidance, your company will achieve the 
ultimate Internet marketing approach, and gain the specific Internet solutions to suit its unique 
corporate needs. 
 
 
9.2 Other web promotion products from Apex Pacific 
 
Apex Pacific is your one stop shop for all of your Internet marketing promotion needs. The 
Dynamic Web Promotion Software range contains all of the most powerful #1 "ALL-IN-ONE " 
Internet marketing and web promotion tools that you need to explode your business on the 
Internet. We are widely recognized as the world leader in quality Internet Marketing and Web 
Promotion software. 
 
Dynamic Submission 2000  - The #1 All-In-One web promotion and search engine submission 
tool that drives traffic to your web site for FREE. 
 
Dynamic Mail Communicator  - Most powerful All-In-One  email marketing tool that sends 
"personalized" messages to your clients and subscribers, stay in touch with customers, keep your 
customers coming back to buy from you. 
 
Dynamic KeywordBid Maximizer - Manage your keywords and bids for ALL the other important 
"Pay-Per-Click" search engines , maintain your position at the lowest cost possible by fixing the 
bid GAPs.  
Dynamic Link Promoter  - Most powerful link promotion tool that manages your link partners, 
tracks your link page, generates new link partners and send "Personalized" invitation messages, 
creates link pages automatically and promotes them. 
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Please click the "Help" menu item from the menu bar and then choose the "Dynamic Software on 
the Web ..." menu item from more details. 
 
 
 
 
 
 
 
9.3 Contacting Apex Pacific 
 
Apex Pacific Pty Ltd 
Suite 2, Level 1,  
6 - 8 Crewe Place, 
Rosebery NSW 2018 
Australia 
Phone: +61 2 9662 3433 
Fax: +61 2 9662 3422 
Email: 
Sales/Products Enquiry: sales@apexpacific.com 
Support/Customer Service: support@apexpacific.com 
 
Web:  
http://www.apexpacific.com 


